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Introduction

The Single-event Wind Erosion Evaluation Program (SWEEP) is a process-based computer
model that simulates wind erosion for a single-day storm event. The model consists of the
EROSION submodel of the Wind Erosion Prediction System (WEPS) model coupled with
a simple graphical user interface.

Installation

SWEEP can be downloaded at: www.weru.ksu.edu/weps
This is the WEPS model web page from which one can download a number of WERU
products. The process to download the SWEEP model only is described next.

Click 'Downloads' at the top of the screen. This will take you to WEPS Download
Registration screen. After entering registration information you will proceed to the
Downloads Page for WEPS. Click the latest WEPS version to download the installation
program. The download file consists of an executable file that will allow the user to install
WEPS and SWEEP products onto your Windows computer. When you install and get to the
'Setup Type" screen, choose the 'Custom Installation' option and be sure to at least choose
the options (i.e., remove the red X) for the 'SWEEP'. Follow the prompts to install SWEEP
on your computer. Of course you are free to install any other options you wish. This process
will put an icon on your computer desktop for the options you chose as well as make them
accessible through "Start>Programs>USDA Applications".

Contact WERU if you need assistance at:

Phone: 785-537-5559
E-mail: weps@weru.ksu.edu
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SWEEP Science

Introduction

This section briefly describes the science behind the Single-event Wind Erosion Evaluation
Program (SWEEP). The science portion of SWEEP, is the EROSION submodel of the Wind
Erosion Prediction System (WEPS). For an in-depth description of the equations used in this
model, see the WEPS Erosion Submodel Technical Description (Hagen, 1995).

The objective of the SWEEP model is

¥ . ) to simulate the components of soil

ML loss/deposition over a rectangular

field in response to wind speed, wind

¥ direction, field orientation, and
Erodible Nonerodible £ diti b-h I

D i i region surface conditions, on a sub-hourly
i region basis (Fig. 1). In SWEEP, barriers
-:‘ North may be placed on any or all field
. boundaries as well as within the field.
n ) X When barriers are present, the wind
c Stpniadon speed is reduced in the sheltered area

region angle . .
on both the upwind and downwind
> sides of the barriers. The model

X Distance determines the threshold friction
velocity at which erosion can begin
for each surface condition. When
wind speeds exceed the threshold, the
model calculates the loss/deposition
over a series of individual grid cells
representing the field. The soil/loss
deposition is divided into components of saltation/creep and suspension, because each has
different transport modes, as well as off-site impacts. Finally, the field surface is periodically
updated to simulate the changes caused by erosion.

Figure 1. Schematic of simulation region
geometry. Field orientation, end points of barriers,
and opposite corners of the rectangular simulation
region are input to the SWEEP model.

Parameters Describing Soil Surface Conditions

Surface roughness is represented by both random roughness and oriented roughness. The
parameters used are standard deviation of the surface heights for random roughness and the
height, width of ridge tops, and spacing of ridges for oriented roughness.
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Figure 2. Diagram illustrating components of flat
surface cover inputs to the SWEEP model.

Surface cover is represented at three
levels (Fig. 2). At the first level,
surface rock, aggregates and crust
compose 100 percent of the cover.
At the second level, the parameter is
the fraction of the crusted surface
covered with loose, erodible soil
When there is no crust, this parameter
1S zero. At the third level, the
parameter is the fraction of total
surface covered by flat, random
biomass.

The aggregate density and size
distribution are soil parameters that

determine soil mobility. The dry mechanical stabilities of the clods and crust are input
parameters that indicate their resistance to abrasion from impacts by eroding soil. Surface soil
wetness is also input and used to increase the threshold friction velocity at which erosion

begins.
— 5 Friction velocity
above biomass canopy
STANDING
BIOMASS
stem area &
leaf area
Surface
friction
velocity

Figure 3. Diagram illustrating friction velocity
above standing biomass that is reduced by drag of
stems and leaves to the surface friction velocity

below the standing biomass.

Uniformly distributed standing
biomass is 5 to 10 times more
effective in controlling wind erosion
than is flat biomass, and thus,
standing biomass is treated
separately. = The wind friction
velocity above standing biomass is
depleted by the leaves and stems to
obtain the friction velocity at the
surface that is used to drive erosion
(Fig. 3). Leaves are represented by
a leaf area index and stems are
represented by a stem silhouette
area index.

Erosion Processes Simulated

Soil transport during wind erosion
occurs in three modes: creep-size
aggregates, 0.84 to 2.0 mm (0.033 -

0.079 in.) in diameter, roll along the surface; saltation-size aggregates, 0.10 to 0.84 mm
(0.004 - 0.033 in.) in diameter, hop over the surface; and suspension-size aggregates, less
than 0.01 mm (0.004 in.) in diameter, move above the surface in the turbulent flow.
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Variations in friction velocity, aggregate density, and sediment load obviously may change
the mass of aggregates moving in a given mode. Saltation and creep are simulated together
because they have a limited transport capacity that depends mainly upon friction velocity and
surface roughness. The suspension component is simulated with no upper limit on its
transport capacity at the field scale. A portion of the suspension component is simulated as
PM-10 (i.e., particulate matter less than 10 micrometers (0.0004 in.) in diameter), which is
regulated as a health hazard.

Top of conirol volume (diffusion zone) Multiple physical erosion Processes
are simulated in the SWEEP model,
and these are illustrated for a single

o il . e S g grid cell in Fig. 4. The two sources
R of eroding soil are emission of loose
soil and entrainment of soil abraded

- et fromclods and crust. These sources
Emission of Abrasion of Brealage of S are apportioned between

Loose soil clodsicrnst saltagonicrom saltation/creep and suspension
Sikadon'ereee components on the basis of the

b Rhechage source process and soil

O, A characteristics. Particulate matter

b less than 10 microns (PM10) is

xBpe considered a component of

Figure 4. Diagram illustrating processes simulated suspension. Three processes
by the EROSION submodel on a bare soil surface in deplete the amount of moving
an individual grid cell. saltation/creep. These include

trapping in surface depressions,
interception by plant stems/leaves, and breakage of saltation/creep size particles and
aggregates into suspension-size.

Simulation of surface rearrangement is accomplished by allowing emissions to deplete the
loose soil and armor the surface in the upwind field area. In contrast, processes such as
abrasion of the protruding aggregates and trapping in depressions dominate in downwind
areas and lead to smoothing the surface and a build-up of loose saltation/creep. A build-up
of saltation/creep often occurs, because the transport capacity may be satisfied, but abrasion
of clods/crust continues to create additional saltation/creep-size soil.
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Figure 5. Diagram illustrating downwind transport
capacity for saltation & creep, but a continuing
increase in transported mass of suspension-size soil
downwind.

Typical behavior of the downwind
soil discharge simulated along a line
transect for the saltation/creep and
suspension components is illustrated
in Fig. 5. The suspension
component keeps increasing with
downwind distance, even though
saltation/creep reaches transport
capacity.  This is because the
sources for suspension-size soil are
usually active over the entire field.
These sources include emissions
from impacts on loose soil, abrasion
from clods/crust, and breakage from
impacting saltation/creep-size
aggregates. Moreover, the
suspension component has a
transport capacity many times larger

than that of saltation/creep, so on large fields it is the ‘freightliner’ for moving soil whereas
saltation/creep is merely the ‘pickup truck’. The vertical extent of the suspension component
at transport capacity is on the order of a few kilometers while the vertical limit of
saltation/creep is on the order of approximately one meter.

Outputs

The SWEEP model calculates total, suspension, and PM-10 soil loss/deposition at each grid
cell in the field. The grid cell data are summarized reported to users as averages over the field
for selected periods. The model also calculates the components of soil discharge crossing
each field boundary. These are reported to users, according to the size ranges of aggregates
as saltation/creep, suspension, and PM-10. These latter outputs are useful for evaluating off-
site impacts in any given direction from the eroding field.
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Interface Reference

The installation process described previously, should put the SWEEP icon on your desktop,
ifyou chose that option. The program s also accessible through "Start>All Programs>USDA
Applications>WEPS 1.0>SWEEP". Click the desktop icon or access the program through
the “Start” menu to begin the SWEEP interface. The SWEEP interface (Fig. 6) shopuld
appear at startup and consists of a menu bar and five input screens arranged in tabs across the
top of the screen. Output options include text output files as well as 3D graphical output
capabilities for the entire day as well as subdaily (e.g., hourly) plots.

Single-event Wind Erosion Evaluation Program Bare_Strips_2BarrierUp.in

File Run View Tools Help

Field | Biomass rSniILayers rSuiISur[ace fW’eather

X-Length 500.0/m
Y-Length 800.0/m

Angle oo
| Add New Barrier |
| Remove Selected |
| ¥ | ¥ | %2 | ¥2 | Height | Wiith Porosity
| Barrier Type | {meters) | {fract)
Barrier 1 |Grass Barrier(2 row) [+ 0.0 ] 00| s00.0) us| 1.0 0.5
Barrier 2 Snow fence [~ zaon[  oo] 2s00[ soool 12 10| 06

Corn(2 row) el
Corn(3 row)

Corn(4 row)

'Wheat/Rye(1 row)

Wheat/Rye(2 row)

'WheatRve(3 [Uw)

Figure 6. The main SWEEP screen showing the Field tab.
The dropdown list for selecting a barrier type is shown.
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Menu Bar

The menu bar is at the top of the SWEEP screen to allow easy access to the main functions
of the model. Each item on the menu bar is described next.

File

The ‘File’ menu is a drop down list of various computer operations pertaining to SWEEP
files. The File menu contains the following options:

>

Run

New - Allows user to create a new input file from scratch (Ctrl-N).

Open - Allows user to open an existing input file (Ctrl-O).

Save - Saves the currently displayed input file to its current file name (Ctrl-A).
Save As - Saves the currently displayed input file under a different file name (Ctrl-A).

Load Soil File - Opens a file chooser to select a WEPS generated soil file (*.ifc)
which is then used to populate the soil tabs.

Load SSURGO File - Opens a list of soils previously obtained from the NRCS Soil
Survey Geographic (SSURGO) database.  This opens a window titled
‘Select SSURGO Soil’. Navigate through the database tree to find the soil survey
area (or county) desired then select a soil. A full description of how to navigate to
select a soil as well as how to download soil data from the SSURGO database and
convert them to the correct file format is available in the Appendix of the SWEEP
User Guide.

Exit - Exit the SWEEP program (Ctrl-X).

This menu allows the user to run SWEEP using the current inputs specified on the SWEEP
screen. Before running a SWEEP simulation, the user should save the input file first. The
‘Run’ menu on the SWEEP screen displays the following options:

>

‘Run’ - Begin a SWEEP simulation using the current selected inputs (Ctrl-R).

‘Find Threshold’ - Opens a window that allows the user to select a wind station for
which to calculate wind speed threshold at which erosion will occur as well as other
wind parameters by direction and month. Once a stations is selected, clicking the
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‘Run’ button on the window generates a table that displays the following information
by month and direction.

*  Threshold (m/s) - Wind speed from the specified direction at which erosion
begins based on the given surface conditions (soil and biomass).

*  Winds > Threshold (%) - Percent of winds coming from the specified direction
for this month that exceeds the threshold wind speed for that direction.

*  Dir Prob (%) - Probability of wind coming from the specified direction for the
month.

*  Thresh Prob (%) - Probability of any wind exceeding the threshold wind speed
from any direction for the month.

View
This menu allows the user to view input or output for the most recent (i.e., most current)
SWEEP run. The View menu on the SWEEP screen displays the following options:

> ‘Input Text’ - Displays the current SWEEP input file.
> ‘Output Text’ - Displays the most recent output file (Ctrl - ).
> ‘Graph Total’ - Displays the Sweep Soil Erosion Viewer that allows the user to view

3-D plots of various SWEEP outputs for the day (Ctrl - G ).

> ‘Graph Subdaily’ - Displays the Sweep Soil Erosion Viewer that allows the user to
view 3-D plots of various SWEEP outputs for each time period (e.g., hour) ofthe day
(Ctrl - D).

> ‘Threshold Run’ - Displays the result of the ‘Find Threshold’ obtained under the

‘Run’ menu. To open a previously created Threshold Run table, one must open an
input file for the previously created run.

Tools
This menu contains miscellaneous tool options for SWEEP, including:

> ‘Configure’ - Displays a tabbed window with the following various configuration
options for SWEEP (Ctrl - C).
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«  ‘Files’ - Tab that allows the user to select executable files and command-line
arguments (see Appendix of the WEPS User Manual for the command-line
argument definitions):

SWEEP exe - Enter the path and file name for the default SWEEP executable
or click the folder icon 1  to display a file chooser.

SWEEP cmd - Enter the default SWEEP command-line arguments (see
Appendix for argument list).

Soil DB - Either the default directory for “ifc” soil database files or the name of

a SSURGO Microsoft Access database file, including the path (click the folder
icon [1 to display a file chooser). If an “ifc” directory is entered, the ‘Soil DB
spec’ field below should be left blank.

Soil DB spec - Enter the JDBC:OBDC driver specification for accessing
SSURGQO soil data in a Microsoft Access database file. This field should be left
blank if the “Soil DB” field specifies a directory containing “ifc” soil files.

Work Directory - Enter the path and file name for the default SWEEP working
directory or click the folder icon L]  to display a file chooser.

Wind DB file - Enter the path and file name for the default wind database file
or click the folder icon L1  to display a file chooser.

Wind Index File - Enter the path and file name for the default wind database
index file or click the folder icon _1  to display a file chooser.

*  ‘Run’ - Tab for run options:

Inputs - Enter the number of simulation grid points in the x and y directions as
well as the number for surface updating interval. This interval is the time
between surface update calculations in seconds. If the “Turn off surface
updating” box is checked, the surface conditions will not be updated as a result
ofeerosion. Note that the default number of grid points in each direction is 30 for
a field without barriers and 60 for a field with barriers. Significantly increasing
the number of grid cells may result in model instability.

Outputs - Click the check box to enable outputs for the listed items.
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*  ‘Email’ - Tab for email settings:
Sender Addr - Enter the default email address of the sender.
SMTP Server - Enter your mailhost SMTP server address.
Comments - Default recipient for comments to WEPS developers.

Bugs - Default recipient for a bug report.

> ‘Email’ - Displays a window containing the SWEEP online help system (Ctrl - E).

Help

This menu contains help options for SWEEP, including:

> ‘About’ - Displays the Build Date, Release Number, and Java Runtime Version used
for SWEEP.

> ‘Help’ - Displays a window containing the SWEEP online help system (F1).

Tabs

Each input item is arranged into tabs just below the menu bar. Click on the tab to access
input page. Contents of each tab is described next. A range of absolute values, which are
valid for SWEEP, are given for each parameter where applicable. Values out of range have
not been extensively tested and effects on model outputs are unknown. Methods for
estimating some parameters from other known properties are also given.

Field Tab

The Field tab (Fig. 6) describes the field dimensions and orientation. It also describes barrier
placement and properties. A Field View panel (Fig. 7) is located to the upper right of the
SWEEP Field tab. This panel is for viewing only and is not editable. It is designed to give
the user a view of'the field size, shape, and orientation (green). The placement of any barriers
present is also displayed (red). The field tab parameters are defined next.

X-Length - The length of the simulation region in the X-direction, meters.
Absolute range: 10.0 to 1600.0

Y-Length - The length of the simulation region in the Y-direction, meters.
Absolute range: 10.0 to 1600.0
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Figure 7. Field View panel for a rectangular field
with three barriers (red).

Angle - Orientation of the simulation region in degrees, clockwise from North
(i.e., North = 0.0, East = 90.0, etc.).
Absolute range: 0.0 to 360.0

Add New Barrier -  Allows the user to add a barrier to the field and provide a reference
name for that barrier.
Absolute range: 0 to 500

Remove Selected -  Allows the user to remove the selected barrier from the field.

Barrier Table

The barrier table is at the bottom of the field tab and allows easy addition of barriers and
editing of their properties. Clicking on a barrier in the Field View panel highlights the
properties for that barrier in the Barrier Table below. Note that although up to five hundred
barriers may be simulated, large numbers (>5) of barriers and barriers within the field borders
have not been extensively tested. Barriers at an angle to the field borders are also allowed but
are similarly not extensively tested.

Barrier - Displays the reference name for the barrier specified by the user when
clicking the “Add Barrier” button.

Type- Select from a list of previously defined barrier types by clicking the
down arrow [  to the right ofthe cell. Upon selection of a barrier, the
properties will be entered. The properties may be edited in which case
the type name will be changed to <custom>. One may also choose
<custom> to specify barrier properties from scratch.

X1,Yl1 - The X,Y coordinate of the first linear barrier end point, meters.
Absolute range: 0.0 to ?
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X2,Y2- The X,Y coordinate of the second linear barrier end point, meters.
Absolute range: 0.0 to ?
Height - The average height of the barrier, meters.
Absolute range: 0.0 to ?
Width - The average width of the barrier, meters.
Absolute range: 0.0 to ?
Porosity - The Average barrier optical porosity (1.0 - silhouette area), m’/m’.

Biomass Tab

Absolute range: 0.0 to 1.0 (i.e., 1.0 = solid barrier)

The Biomass tab describes the crop and biomass conditions on the soil surface.

Residue average height -

Residue stem area index -

Residue leaf area index -

Residue flat cover -

User Manual

The average height of standing residue, meters.
Absolute range: 0.0 to 3.0

The residue stem area index, m*/m’. This represents the area
of the stems only (no leaves) per square meter as viewed
parallel to the soil surface. The user may also click the
“Estimate” button | Estimate | to the right of the input field
to open an input window to estimate residue stem area index
based on average temperature for the day (° C) and elevation
(meters). The value in this field may also be edited if desired.
Absolute range: 0.0 to 3.0
Estimated by: RSAI = stem diameter (m) * stem

height (m) * stem population (#/m°)

The residue leaf area index, m*/m’.
Absolute range: 0.0 to 3.0

The flat biomass cover, m*/m’. The user may also click the

button | Pictures | to the right of the input field to display
photo examples (see Appendix) of residue cover for wheat

straw. Placing the cursor over the photo displays the amount

of residue below the photo. Clicking on a photo closes the

window and enters the cover value into the filed. The value

in this field may be edited if desired.

Absolute range: 0.0 to 1.0
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Growing crop average height -
The average height of the growing crop, meters.
Absolute range: 0.0 to 3.0

Growing crop stem area index -

The growing crop stemarea index, m?/m’. This represents the
area of the stems only (no leaves) per square meter as viewed
parallel to the soil surface. The user may also click the
“Estimate” button | Estimate | to the right of the input field
to open an input window to estimate growing vegetation stem
area index based on average temperature for the day (° C) and
elevation (meters). The value in this field may also be edited
if desired.

Absolute range: 0.0 to 3.0

Estimated by: CSAI = stem diameter (m) * stem

height (m) * stem population (#/m°)

Growing crop leaf area index -
The growing crop leaf area index, m*/m’.
Absolute range: 0.0 to 12.0

Row spacing - The row spacing cover, meters. Use a value of 0.0 if not
planted in rows (e.g., broadcast seeded).
Absolute range: 0.0 to ?

Seed placement - Specify location of seed as either on the ridge top or in the
bottom of the furrow. The value doesn't matter if no ridges

exist or if broadcast seeded.

Soil Layers Tab

The Soil Layers tab describes the soil properties in each layer of the soil. Note that the
current version of SWEEP only accounts for the surface layer properties when simulating
erosion. Simulating erosion for lower layers is described at the end of the Soil Layers tab
discussion.

Number of layers - The number of soil horizons or layers for which properties are
reported. NOTE: Only the top layer (layer 1) is used in the
current version of SWEEP.

Absolute range: 1 to 3

User Manual Printed 9 February 2007



SWEEP

Thickness -

Bulk density -

Sand fraction -

Very fine sand fraction -

Silt fraction -

Clay fraction -

Rock volume fraction -

Avg aggregate density -

User Manual
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The thickness of each soil layer, millimeters.
Absolute range: 0.0 to ?

The oven dry weight of the less than 2 mm soil material per
unit volume of dry soil, Mg/m3.
Absolute range: 0.8 to 1.6

Mineral particles 0.05 to 2.0 mm in equivalent diameter as a
weight fraction of the less than 2.0 mm fraction, kg/kg.
Absolute range: >0.0 to 1.0
Estimated by: sand = 1.0 - (silt + clay)

Mineral particles 0.05 to 0.1 mm in equivalent diameter as a
weight fraction of the less than 2 mm fraction, kg/kg.
Absolute range: 0.0 to 1.0

Mineral particles 0.002 to 0.05 mm in equivalent diameter as
a weight fraction of the less than 2.0 mm fraction, kg/kg.
Absolute range: >0.0 to 1.0
Estimated by: silt = 1.0 - (sand + clay)

Mineral particles less than 0.002 mm in equivalent diameter as
a weight fraction of the less than 2.0 mm fraction, kg/kg.
Absolute range: >0.0 to 1.0
Estimated by: clay = 1.0 - (silt + sand)

The volume fraction of the layer occupied by the 2.0 mm or
larger (20 mm or larger for wood fragments) on a whole soil
basis, m’ /m’.

Absolute range: 0.0 to 1.0

The oven dry weight of the less than 2 mm soil aggregates per
unit volume of dry soil aggregates, Mg/m3.
Absolute range: 0.6 to 2.5
Estimated by:
ag den=2.01 *(0.72 + 0.00092 * layer depth)
for layer depth =< 300 mm
ag den=2.0
for layer depth > 300 mm
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Avg dry aggregate stability - Mean of natural log of aggregate crushing energies, In(J/kg).
Absolute range: 0.1 to 7.0
Estimated by:
ag stab=0.83 + 15.7 * clay - 23.8 * clay 2

GMD of aggregate sizes - Soil aggregate geometric mean diameter of the modified log-
normal distribution, mm.
Absolute range: 0.03 to 30.0
Estimated by:
ag gmd = exp(1.343 - 2.235 * sand - 1.226 *
silt - 0.0238*sand/clay ® + 33.6 * om +
6.85*CaCO)*(1.0 +0.006*layer depth)

GSD of aggregate sizes - Soil aggregate geometric standard deviation of the modified
log-normal distribution, dimensionless.
Absolute range: 1.0 to 20.0
Estimated by:
ag gsd =1.0/(0.0203 + 0.00193(aggr. gmd)
+0.074 / (aggr.gmd) )

Minimum aggregate size -  Lower limit of the modified log-normal aggregate size
distribution, mm.
Absolute range: 0.001 to 5.0
Estimated by: ag min = 0.01

Maximum aggregate size -  Upper limit of the modified log-normal aggregate size
distribution, mm.
Absolute range: 1.0 to 1000.0
Estimated by:
ag max = (ag gsd) * (ag gmd) + 0.84°
where p = 1.52 * (ag gsd)'o‘449

Soil wilting point water content -
The amount of soil water retained at 15 bars (1500 kPa),
expressed as a percentage of the less than 2 mm, oven-dry soil
by volume, Mg/Mg.
Absolute range = 0.0 to ??
Estimated by: Saxton, et al. (1986)
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Soil wilting point water content -
The amount of soil water retained at 15 bars (1500 kPa),
expressed as a percentage of the less than 2 mm, oven-dry soil
by volume, Mg/Mg.
Absolute range = 0.0 to ??
Estimated by: Saxton, et al. (1986)

At the bottom of the ‘Soil Layers’ tab are two arrow boxes. The left arrow [ = | can be
used to cycle the lower layers to the surface. This may be useful in simulating fields that have
had their surfaces removed, such as for construction. The right arrow cycles the layers

down creating a “blank” layer at the surface. This may be useful in simulating an amendment
to the original surface. Note! This function cannot be reversed and the user may have to
reload the soil if the layers are cycled past the desired layer. The user is therefore advised to
save the soil file before performing any cycling of layers to avoid loss of soil data.

Soil Surface Tab

The Soil Surface tab describes the physical properties of the soil surface.

Surface crust fraction - Fraction of surface covered with consolidated soil, as opposed
to aggregated soil, m*/m’.
Absolute range = 0.0 to 1.0

Surface crust thickness - Average thickness of the consolidated zone in the surface
layer, mm.
Absolute Range: 0.0 to 23.0

Loose material on crust - Fraction of total crusted surface area covered with loose
material on the crust, m*/m’.
Absolute range = 0.0 to 1.0

Loose mass on crust - Mass of the loose, saltation-size soil on top of the surface
crusted area, kg/m’.
Absolute range = 0.0 to 3.0
Estimated by: 0.0

Crust density - The density of the soil crust, Mg/m’.

Absolute range = 0.6 to 2.0
Estimated by: aggregate density
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Crust stability - Mean of natural log of crust crushing energies, In(J/kg).
Absolute range = 0.1 to 7.0
Estimated by: aggregate stability

Allmaras random roughness - The standard deviation of elevation from a plane of a random
soil surface, including any flat biomass adjusted as suggested
by Allmaras et al. (1966), mm. The user may also click the
button | Pictures | to the right of the input field to display
photo examples (see Appendix) of random roughness.
Placing the cursor over the photo displays the roughness
below the photo. Clicking on a photo closes the window and
enters the roughness value into the filed. The value in this
field may be edited if desired.

Absolute range = 1.0 to 70.0

Ridge height - The height of soil ridges from bottom of furrow to top of
ridge, mm. NOTE: If no ridges, then specify 0.0.
Absolute range = 0.0 to 500.0
Estimated by: 0.0

Ridge spacing - Spacing between ridge tops, mm. NOTE: If no ridges, then
specify 0.0, if ridge height > 0.0 then a spacing must be
specified.

Absolute range = 10.0 to 2000.0.
Estimated by: 10.0

Ridge width - Width of the top of the ridge (i.e. bed width), mm. NOTE: If
no ridges, then specify 0.0.
Absolute range = 10.0 to 4000.0
Estimated by: 10.0

Ridge orientation - Direction parallel to the tillage ridge, clockwise from true
North, degrees. (i.e., North/South = 0.0 or 180, East/West =
90.0)

Absolute range = 0.0 to 180.0
Estimated by: 0.0

Dike spacing - Spacing between dikes in the furrow, mm. NOTE: Ifno

dikes, then specify 0.0.
Typical Range: 0.0 to 1000.0
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Snow depth - Average depth of snow on the soil surface, mm.
Typical Range: 0.0 to 1000.0

Hourly surface water content -
The near surface water content for each hour of the day,
Mg/Mg.
Absolute Range: 0.0 to 0.50

Weather Tab
The Weather tab describes the weather parameters for the simulation location.

Air density - The average density of the air at the simulation location for
the day, kg/m’. The user may also click the “Estimate” button
| Estimate | to the right of the input field to open an input
window to estimate air density based on average temperature
for the day (° C) and elevation (meters). The value in this field
may also be edited if desired.

Absolute Range: 0.7 to 1.5

Wind direction - Wind direction (degrees) for the 1 to 3 periods of the day with
the fastest wind speeds, measured clockwise from North.
Typical Range: 0.0 to 359.9

Number of intervals/day to run EROSION -
The number of time steps erosion is calculated for each day.
The is equal to the number of wind speeds input for the day.
Note:
no. time step = 24 means hourly updates
no. time step = 48 means 30 minute updating
no. time step = 96 means 15 minute updating
Absolute range: 24 to 96

Anemometer height - The height of the anemometer above the soil surface at which
the wind speeds were measured, m
Absolute range: 0.5 to 30.0

Aerodynamic roughness at anemometer site -
Aerodynamic roughness at the site where wind speeds were
measured, mm
Absolute Range: 0.5 to 2000.0
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Zo location flag -

Wind/Weibull selection -
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Select the location where the wind data was measured: either
measured at a weather station that was remote from the
simulation site or measured at the field simulation site. If at
weather station location - Zo is a constant. If on the field
location - zo varies based on field surface

Select to either read in Weibull parameters for the location
used to simulate wind speeds or select to enter measured wind
speeds.

Fraction of time winds are calm -

Weibull “c” factor -

Weibull "k" factor -

Wind table -

User Manual

The fraction of time intervals that are calm for the day, hr/hr.
NOTE: This is only available when “Weibull” is selected.
Absolute range: 0.0 to 1.0

The scale parameter “c” for the Weibull distribution describing
the wind speed distribution for the site, m/s. NOTE: This is
only available when “Weibull” is selected.

Absolute range: 0.0 to 30.0

The shape parameter “k” for the Weibull distribution

describing the wind speed distribution for the site, unitless.

NOTE: This is only available when “Weibull” is selected.
Absolute range: 1.0 to 3.0

Wind speeds for each time interval of the day, m/s. Wind data
are typically averages for the period. More frequent than
hourly estimates of wind speed will likely improve accuracy of
estimated erosion. Likewise the maximum “instantaneous”
wind speed for each time period is better than an hourly
average.

Notes: The number of wind speeds must equal the “Number

of intervals/day to run EROSION” parameter entered

previously. This is only available when “Wind” is selected.

Each wind speed must be delimited by a tab or white space.
Absolute range: 0.0 to ??
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Making a SWEEP Run

All available input parameters must have a value for SWEEP to successfully run. The user
has three options for populating the input parameters on the tabs. One may, 1) open a
previously saved run, which may be run as is or parameters may be modified and then run,
2) load a soil file which populates soil dependent parameters allowing the user to populate
remaining parameters, 3) populate all parameters from scratch. The user must save newly
created run parameters under a file name through the File menu prior to a run. If the user
tries to make a run without saving parameters to a file, a prompt will appear asking the user
to save the data to a file. Note that known characters that are invalid in SWEEP file names
include: \/ <> | ?7* & “~"°

When available input parameters have been populated within each tab and the file saved,
selecting ‘Run’ from the Run menu begins a SWEEP simulation. You may briefly see a run
dialog window appear on the screen during the simulation run. A run typically takes less than
a few seconds.

Viewing Outputs

After the run completes, the user may click the “View” menu to select options to view the
text input file parameters, view the text output file, and open the Soil Erosion Viewer, a
simple 3-D graphical program to view graphs of the total grid data or view the subdaily
graphical data. One may also view the previously generated threshold run table. The output
file is placed by default in the same directory as the input file and has the same name as the
input file name with a ‘“.egrd’ extension.

The output file is the raw output from the model and has in-line documentation describing
each section of output. The output file provides the following information. First, it echoes
the input values. It then provides erosion loss (kg/m of border width) passing each border
of the field in terms of total, creep+saltation, suspension, and PM10. Next, it provides the
amount of soil leaving each field grid cell in terms of total, creep+saltation, suspension, and
PM10. Negative values are a net loss and positive values are a net gain (i.e., deposition).
Finally it gives averages for field and boundary losses for total, creep+saltation, suspension,
and PM10.
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Soil Erosion Viewer

The SWEEP Soil Erosion Viewer is a simple graphical viewer that provides 3-D plots of field
erosion loss and a table of field grid data being plotted. The Soil Erosion Viewer is accessed
using the “Graph” menu items under the SWEEP “View” menu bar option. Right clicking
within the graph area displays formatting and other customizing options for the viewer.

Daily Total Output

£ Soil Erosion Viewer barrier_none.egrd

File Type View

Suspension Soil Loss
X Length
.6-61 500 1000
6.03 \ | . !
5.45

0 500 1000
X Length

o 1 2 8 4 i
0.240 0.240 0.240 0.240 0.240 0.240
0.440 0.490 0.490 0.490 0.430 0.430
0.880 0.880 0.880 0.880 0.880 0.830
1.330 1.330 1.330 1.330 1.330 1.330
1.880 1.880 1.880 1.880 1.880 1.880
2400 2.500 2.500 2.500 2.400 2400
130 3.130 3.130 3.1 313 13
720 3720 3.720 3.7 372 7
100 4.100 4.100 4.1 4.10 101

Figure 8. The Soil Erosion Viewer screen.

Figure 8 shows the graph window for soil loss for the day. A menu at the top of the Soil
Erosion Viewer screen provides the following graphing functions.

File
The ‘File’ menu is a drop down list of various computer operations pertaining to SWEEP Soil

Erosion Viewer. The File menu contains the following options:

> New - Allows the user to open another copy of the current output file into the
SWEEP Soil Erosion Viewer (Ctrl-N).

> Open - Allows user to open a previously created output file into the SWEEP Soil
Erosion Viewer.

> Exit - Exits the SWEEP Soil Erosion Viewer.
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Type
This menu item allows the user to select various SWEEP outputs to plot. Click a menu item
to select for plots of Total, Creep/Saltation, Suspension, or PM10 soil loss from the field grid
cells.

View
This menu item allows the user to rotate the graphical view. Click a ‘radio button’ to rotate

the plot view to the right or to the left.

Period
This menu item is not yet defined.

Below the Menu bar is a drop down list which allows the user to select for the display of
total, saltation/creep, suspension, or PM10 soil loss by grid cell for the day.

Below the graphical output is a table depicting the selected output for each grid cell followed
by a listing to loss totals for the entire field.

Subdaily Output

Soil Erosion Viewer BareField.sgrd
File Type View Period

Total Soil Loss [][1 1121200 [~]

Total Soil Loss (kgim*2)

.3-3“ X Length
3.53
3.22

2.01
2.61
2.30

1.99
1.68

137 =,
I1.[Iﬁ !

0.75 !

.44 (0] 500 1000

X Length

1] il 2 3 4 5 [ i, 8 2]
7 # . 7 .37 7

7 i . 7 37! 7
7 i . 7 .37 7

NIEIEE

E e

[« " [0[»

Total Soil Loss 3.3859 Top (N) Loss 0.00
Salt/Creep Loss 1.0951 Bottom (S) Loss 0.00
‘Suspension Loss 2.2908 Right (W) Loss 0.00
PM10 Loss 0.116453 Left (E) Loss 3385.86

Figure 9. The Subdaily Soil Erosion Viewer screen.

Figure 9 shows the graph window of the grid soil loss for sub-periods for the day (e.g.,
hourly). The number of intervals per day for which erosion is calculated is set under the
“Weather” Tab. By changing the number of intervals, the user can select the time interval
between erosion calculations (e.g., 24 = hourly or 48 = 2 hour intervals).
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Clicking the right or left arrow keys allows the user to step forward or back through the time
periods of grid loss output. A menu at the top of the Soil Erosion Viewer screen provides
the following graphing functions.

File
The ‘File’ menu is a drop down list of various computer operations pertaining to SWEEP Soil
Erosion Viewer. The File menu contains the following options:

> New - Allows the user to open another copy of the current output file into the
SWEEP Soil Erosion Viewer (Ctrl-N).

> Open - Allows user to open a previously created output file into the SWEEP Soil
Erosion Viewer.

> Exit - Exits the SWEEP Soil Erosion Viewer.

Type
This menu item allows the user to select various SWEEP outputs to plot. Click a menu item
to select for plots of Total, Creep/Saltation, Suspension, or PM10 soil loss from the field grid
cells.

View
This menu item allows the user to rotate the graphical view. Click a ‘radio button’ to rotate
the plot view to the right or to the left.

Period
This menu item is not yet defined.

Below the Menu bar is are two drop down lists. The left one allows the user to select for the
display of various erosion parameters and soil loss totals by grid cell for each period of the
day. The right drop down lists the time period that is displayed. The time period displayed
may be stepped through by using the right and left arrow keys.

Below the graphical output is a table depicting the selected output for each grid cell followed
by a listing to loss totals for the entire field.
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Soil data for a SWEEP simulation run may be obtained from the Natural Resources
Conservation Service - Soil Survey Geographic (SSURGO) database file. Accessing this
database will allow the population of many of the soil parameters on the SWEEP screen.

& select SSURGO Soil EEX

[l 7]

% [ 55URGO Soil Survey Area
O [T AKE12 - Copper River Area, Alaska
& [ AKE48 - Gulkana River Area, Alaska
® I FL113 - Santa Rosa County, Florida
© I FL115 - Sarasota County, Florida
@ [T MN113 - Polk County, Minnesota
Q 3 MTEOD - Glacier County Area and Part of Pondera County, Montana
@ [ AB - ADEL-BABE COMPLEX, HILLY
@ [ AF - ADEL-FIFER ASSOCIATION, HILLY
& [ AL - ADEL-HANSOM COMPLEX, HILLY
@ [ Ac - ABSHER COMPLEX
@ [J Ad- ADEL LOAM, 0 TO 4 PERCENT SLOPES
[y l=0- ADEL
[ o-BaEE
[y 1-car0
[ Ae - ADEL LOAM, 4 TO 10 PERCENT SLOPES
[ Ag - ARNEGARD LOAM, 0 TO 2 PERCENT SLOPES
@[] Ah - ARNEGARD LOAM, 2 TO 8 PERCENT SLOPES

EID

-

Figure 10. The ‘Select SSURGO Soil” window.

Clicking on the SWEEP ‘File’
menu and then clicking ‘Load
SSURGO File’, opens a window
titled ‘Select SSURGO Soil’ (Fig.
10). Navigate through the database
tree to find the soil survey area (or
county) desired. Navigation is
performed by clicking on the ‘key’
symbol to open &  the display to
the next level of the tree. To close
a level of the tree, click the ‘key’
symbol to close ¥ the level of the
tree. The soil files are listed
according to the soil map unit
symbol, map unit name, surface
texture, and local phase. Selecting
a soil then displays its components
and the percentage that each

component contributes to the map unit. The user can choose to select the dominant soil for
the field or selecth the most erodible soil of the field. Click on a soil component to highlight

it and click the ‘Select’ buttoni Select

at the top of the screen (or double click the component

with the left mouse button). This action returns the user to the main SWEEP screen and
converts the soil from the SSURGO database to a WEPS soil file format. SWEEP then loads

the data into many of the Soil Layer and Soil Surface tabs. Clicking the ‘Cancel’ | Cancel [

button in the ‘Select SSURGO Soil’ window aborts the selection of a new soil.
opens the general help system for SWEEP.

‘Question’ button ?
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Downloading SSURGO Soil Data

This section describes how to download soil data from the NRCS Soil Data Mart and how
to extract it for use within WEPS and SWEEP. A Microsoft Access database is available for
importing the data in the export file. You must have Microsoft Access 97 or later installed
on your PC.

Soil data for NRCS and most other users in the US, is currently available for download from
the NRCS Soil Data Mart at: http://soildatamart.nrcs.usda.gov/ . Soil survey data that is
exported from the Soil Data Mart is in what is referred to as “SSURGO” (Soil Survey
Geographic) format. To obtain soil data for a Soil Survey Area of interest, go to the Soil
Data Mart and click ‘Select State’ at the top of the Soil Data Mart screen. Select the desired
state then click ‘Select Survey Area’ or ‘Select County’. Select the soil survey area, then
click ‘Download Data’. On the download screen select ‘Tabular Data Only’, select the
version of Microsoft Access on your computer, and enter your e-mail address, then click
‘Submit Request’. You will see a message stating “Your request has been logged. At a later
time you will receive an e-mail with a link to download the export file. The format of an
export file name is: soil ssasymbol.zip, where ssasymbol is the soil survey symbol of the
corresponding soil survey area.

After the export file has been copied to your PC, it must be unzipped by using either WinZip
or a similar program. For additional information, please see the file named README.txt in
the root directory that is created by unzipping the export file. For additional soil survey areas,
each zip file should be copied and unzipped into individual directories. When an export file
is unzipped, the following directory hierarchy is produced in the directory to which the export
file was unzipped:

\spatial
\tabular

The top-level directory contains the following files:

soil metadata ssasymbol.txt - a Federal Geographic Data Committee (FGDC) metadata file
in plain ASCII format.

soil metadata ssasymbol.xml - the same FGDC metadata file in XML format.
readme.txt - a text file containing additional information.

The root directory will also contain a zipped, empty MS Access SSURGO template database,
if one was requested as part of the download. The non-extension part ofthe zipped template
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database file name varies, but if one was included, it will be the only file in the top-level
directory with an extension of "zip". This file should be unzipped as well.

The directory "tabular" contains any tabular data that was requested. The directory "spatial"
contains any spatial data that was requested. Note that spatial data is not required or
recommended (due to large file sizes) for WEPS or SWEEP. It is possible to request tabular
data from the Soil Data Mart without including the corresponding spatial data, and vice versa.

Tabular data is provided as a set of ASCII delimited files. Each file corresponds to a table
in the SSURGO 2.1 data model. The tabular data isn't particularly useful until it has been
imported into the MS Access SSURGO template database. Current Soil Data Mart
downloads include a template database. Ifatemplate database was not included in the export
file, you can download one from the following URL:

http://soildatamart.nrcs.usda.gov/templates.aspx

To import tabular data, load
the template file into MS
Access. A ‘SSURGO Import’
screen will display, asking for
the full path to the tabular data

Microsoft Access

File Edit view Insert Format Records Tools ‘Window Help

K-B &LV BR¥ o
@W\‘

Ty
SIE SSURGO Import  (Template Version 30)

Nate: This function imports the contents of a SSURGO export into this

database. The SSURGO export must be unzipped before it can be imported. The
directary into which the export is unzipped should not contain data from a
previous SSURGO export, If it does, and you then import from that directory, the
impart may fail due to encountering partial data from a previous export.

|C:\usr\jt\w0rk\weps\soil\suil_ksm32DUU\soiI_ksm3\tabu|ar|

Enter the directory location where the files to be imported reside. Enter bath the
the Ietter of the drive and the fully qualified path to the directory on that drive. For
example "d:itmpisoil_MTEZ7tabulart”. The closing backslash is optional.

0K Cancel

If you are new to this database, please select the Reports tab of the Database
window and open the report titled "How to Understand and Use this Database".

Form YView

UM

Figure 11. WEPS Soil User Interface screen.

directory (Fig. 11). Type (or
cut and paste) the full path of
the tabular directory and click
‘OK’. A list of database tables
will appear and a folder will be
created in the top level
directory. The folder will have
the base name (non-extension
part) of the template name. At
the same time, an MS Access
database file (*.mdb), which
contains the data required for
WEPS, will be created in the
template folder. To import
more than one soil survey area
into a single MS Access
database, run the Import macro
specifying the full path to the

directory the SSURGO data was unzipped into. Repeat the Import macro for each area
desired. When done, save the template database with the imported data to a new name
(*.mdb).
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The SWEEP interface extracts data from the following SSURGO data files located in the
\tabular directory:

chfrags.txt
chorizon.txt
chtexgrp.txt
comp.txt
crstrcts.txt
legend.txt
mapunit.txt
muaggatt.txt
version.txt

If multiple soil survey areas are imported into a single MS Access database, the database may
become very large. To reduce the size of the Access database file, one may run the Export
macro and delete the SSURGO data (*.txt) files created in the tabular directory that are not
listed above before importing into a template Access database.
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Residue Cover Estimation

These photographs (Figs. 12 - 18) may be used as a guide to determine relative residue flat
cover diagonal tape is approximately 4ft 6 in. values. These photos were taken at an oblique
angle to provide an image similar to that seen by an observer standing a few feet from the
plot. The diagonal tape in the photographs is approximately 1.37 meters (4.5 ft).

igre 12. Flat cover of 0.1 m*/m’ wheat residue.
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Figre 14. Flat cover of 0.3 m*/m* wheat residue.
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]

Figure 16. Flat cover of 0.5 m*m’ wheat residue.
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R A SN B VAN -;
Figure 17. Flat cover of 0.6 m*m’ wheat residue.

5 N NA fSia Sl
Figure 18. Flat co

ver of 0.7 m*m’ wheat residue.
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Random Roughness Estimation

This section contains descriptions of soil surface random roughness, defined as the standard
deviation of the elevation from a plane across an area (mm). Random roughness does not
take into account oriented roughness. Randomroughness is primarily the result of aggregate
size distribution, but is also affected by various types of tillage tools. Random roughness
values for typical agricultural management operations are listed in Table 1. Photographs
(Figs. 19 - 27) can also be used as a guide to determine relative random roughness values.
These photos were taken at an oblique angle to provide an image similar to that seen by an
observer standing a few feet from the plot. The sides of the frame in the photographs is 1
meter (3.28 ft).

Table 1. Random roughness values for typical management operations based on a silt
loam soil (Ag. Handbook 537).
Random Roughness Random Roughness
Field Operation (inches) Field Operation (inches)
Fertilizer applicator,

Chisel, sweeps 1.2 anhydrous knife 0.6
Chisel, straight point 1.5 Harrow, spike 0.4
Chisel, twisted shovels 1.9 Harrow, tine 0.4
Cultivator, field 0.7 Lister 0.8
Cultivator, row 0.7 Manure injector 1.5
Cultivator, ridge till 0.7 Moldboard plow 1.9
Disk, 1-way 1.2 Mulch threader 0.4
Disk, heavy plowing 1.9 Planter, no-till 0.4
Disk, Tandem 0.8 Planter, row 0.4
Drill, double disk 0.4 Rodweeder 0.4
Drill, deep furrow 0.5 Rotary hoe 0.4
Drill, no-till 0.4 Vee ripper 1.2
Drill, no-till into sod 0.3
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inches (10 mm).

Figure 20. Random roughn
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Figure 22. Random roughness of 0.75 inches (19 mm).
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Figure 26. Random roughness of 1.70 inches (43 ).
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Fig andom roughness of 2.15 inches (55 mm).

User Manual Printed 9 February 2007



SWEEP SWEEP USER GUIDE - DRAFT 41

SWEEP Command Line Options

Input parameters for SWEEP that must be provided for the simulation period include the field
and barrier dimensions, as well as biomass, soil, hydrology, and weather parameters. Wind
speed can be entered either as Weibull distribution parameters or listed as average wind
speeds for each time period throughout the day. Command line options may be set through
the “Files” tab on the “Configuration” panel accessible under the “Tools” menu. Options not
specified are set to default values internally in the model. Valid command line options for
SWEEP are:

Command Line Options

Usage: tsterode -i"input filename" -x# -y# -t# -u -E -Plot -? -h
Valid command line options:

-?or-h Display the available command line options.

-X# Number of grid points in x direction (min. = 3; max. = 500). The
submodel calculates the loss/deposition over a series of individual,
equal-sized grid cells representing the entire simulation region. The
more grid points, the smaller the area in each grid cell. The
recommended total number of grid cells is 30 for a field without a
barrier and 60 for a field with a barrier. Increasing the number of grid
cells increases the accuracy of the soil loss/deposition estimates, as
well as increases the run time. If not specified, the number of grid
points is calculated within the model.

-y# Number of grid points in y direction (min. = 3; max. = 500). The
submodel calculates the loss/deposition over a series of individual,
equal-sized grid cells representing the entire simulation region. The
more grid points, the smaller the area in each grid cell. The
recommended total number of grid cells is 30 for a field without a
barrier and 60 for a field with a barrier. Increasing the number of grid
cells increases the accuracy of the soil loss/deposition estimates, as
well as increases the run time. If not specified, the number of grid
points is calculated within the model.

-t# Interval for surface updating in seconds (min. = 60 seconds; max. =
86400 seconds). This is used to specify a fixed surface updating
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-u

-1"input_filename"

-Einp

-Erod

-Egrd
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interval and is primarily for testing and evaluation purposes. Because
the erosion code contains an update loop dependent upon the number
of time intervals/day and an inner loop that allows more frequent
surface updating to occur, the interval must be evenly divisible into
both the number oftime intervals/day and 24 (hours in a day). Ifthese
conditions are not met, the program aborts with an error message.

Disable erosion surface updating.

Specify input filename. The input filename must be specified and
listed before the -Einp, -Erod, -Egrd, and -Emit options. Quotes are
required if spaces are within the file name.

Writes (echos) the input file to “input_filename.einp”. This is useful
for debugging purposes. The “input_filename” is the same name as
the input filename with a “.eimp” extension, and will be created in the
same directory specified for the input filename.

Output erosion summary (kg/m?) (positive values are soil loss). The
one line output in the file contains the following:

Total loss, saltation plus creep, suspension, PM10, and the input
filename

The “-Erod’ option requires that the input file (-i"input_filename") be
specified as a command line argument before the “-Erod” option, e.g.:

tsterode -iinput filename.ext -Erod

The “input_filename” in the erosion summary is the same name as the
input filename with a “.erod” extension, and will be created in the
same directory specified for the input filename.

Output grid summary results (kg/m?®) (positive values are soil loss).
The “-Egrd’ option requires that the input file (-i"input_filename") be
specified as a command line argument before the “~-Egrd” option, e.g.:

tsterode -iinput filename.ext -Egrd
The “input_filename” in the grid summary is the same name as the
input filename with a “.egrd” extension, and will be created in the

same directory specified for the input filename.
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Output hourly erosion results (kg/m®) (positive values are soil loss).
The “-Emit’ option requires that the input file (-i"input_filename") be
specified as a command line argument before the “-Emit” option, e.g.:

tsterode -iinput filename.ext -Emit

The “input_filename™ in the hourly erosion results is the same name
as the input filename with a “.emit” extension, and will be created in
the same directory specified for the input filename.

Enable printing of a file that can be used to plot various data. The
data is appended to the file for each run.

Output all grid cell values for selected grid cell variables (e.g., RR,
ridge ht, friction velocity, etc.) as well as the standard erosion results
for each subdaily period. Each "period" is identified by the "yy mm dd
hr variable name title" prior to the grid cell values. The “-Esgrd’
option requires that the input file (-i"input_filename") be specified as
a command line argument before the “-Esgrd” option, e.g.:

tsterode -iinput filename.ext -Esgrd
The “input_filename” in the grid summary is the same name as the

input filename with a “.sgrd” extension, and will be created in the
same directory specified for the input filename.

Printed 9 February 2007
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